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1. Introduction

1.1. FMI Connection for NI VeriStand & LabVIEW

The FMI Connection is an add-on for NI VeriStand that enables the usage of FMU
models on windows and Phar Lap ETS target platforms. From version 1.5.1 it enables
also LabVIEW Model Interface Toolkit to natively import FMU models.

2. Installation

2.1. Supported Platforms

The FMI Connection is supported on the following OS:
Windows 8 (32-bit and 64-bit)

Windows 7 (32-bit and 64-bit)

Windows Vista (32-bit and 64-bit)

Windows XP Service Pack 3 (32-bit)

Windows Server 2003 R2 (32-bit)

Windows Server 2008 R2 (64-bit)

2.2. Required Software

If you plan to import your FMU models in VeriStand, than version 2011 or 2012 or
2013 or 2014 of NI VeriStand is required to install FMI Add-On, apart from that this
software shares the same compatibilities and requirements of the VeriStand version
you have installed on your machine. If you also plan to use your FMU models in
LabVIEW, than you need to have installed on your machine, versions 2013 or 2014 of
LabVIEW together with the corresponding version of the Model Interface Toolkit.

Both Real-Time targets of the FMI Add-On for VeriStand and LabVIEW require Phar
Lap ETS on the host target to be installed.

2.3. Installation Procedure
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e Run the installer FMItoNI1VS201X_1.5.1.exe, and click Next on welcome

page.

e Setup - FMI Add-on for NI VeriStand & LabVIEW

& DOFWare

VeriStand & LabVIEW Setup
Wizard

V.

FM' Add-o on your computer,

This will install FMI Add-on for NI VeriStand & LabVIEW 1.5.1

i Engira Itis recommended that you doze all other applications before
continuing.
fnan
‘&P‘Hj T Click Mext to continue, or Cancel to exit Setup.
—
1!&‘ Crass
5 .o

=] @
ﬂ Welcome to the FMI Add-on for NI

[ Next > ]I Cancel

)

Figure 1 First installer dialog, welcome text.

i Setup - FMI Add-on for NI VeriStand

=] [

License Agreement

Please read the faollawing important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement befare continuing with the installakion.

DOFPWARE End-User License Agreement ("EULA") is a legal agreement. between
vou {either an individual or a legal entity) and DOFWARE for DOFWARE software
productis) identified above which may include associated software components,
media, printed materials, and "online” or eleckronic documentation {"SOFTWARE
PRODUCT"), By installing, copying, or otherwise using the SOFTWARE PRODICT,
vou agree to be bound by the kerms of this EULA. This license agreement
represents the entire agreement concerning the program between wou and
DOFWARE, (referred to as "licenser™), and it supersedes any prior proposal,
representation, or understanding between the parties. If vou do not agree to the
terms of this EULA, do not install or use the SOFTWARE PRODUICT.

T accept the agreement

@ I donot accept the agreement

< Back Mexk = Cancel

Figure 2 License agreement

Read the license agreement, and click | Agree to agree to the terms and
conditions.

Choose the directory where the FMI Connection should be installed. The
default installation directory, which will be pre-selected, is C:\Program
Files\FMUtoNIVS.
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Jad Setup - FMI Add-on for NI VeriStand B

Select Destination Location
Where should FMI Add-on For NI VeriStand be installed?

Setup will install FML Add-on Far NI YeriStand into the fallowing Folder.

Ta conkinue, click Mext, IF vou would like to select a different Folder, click Browse.

g

Al least 16.2 ME of free disk space is required.

[ < Back ][ Mext = ][ Cancel ]

Figure 3 Third installer dialog, select installation folder.

e Select the NI VeriStand and LabVIEW Versions you had installed on your
machine.

Setup - FMI Add-on for NI VeriStand & LabVIEW [ = |
p

Select Components
Which components should be installed?

Select the components you want to install; dear the components you do not want to
install. Clidk Next when you are ready to continue.

’Custorn installation - ]
D FMI Add-on for MI Veristand & LabvIEW 2011 11,0 ME =
D FMI Add-on for ML Veristand & LabvIEW 2012 11,0MB |
FMI Add-on for MI VeriStand & LabVIEW 2013 11,0MB | =
FMI Add-on for MI VeriStand & LabVIEW 2014 11,1 MB 1
FMI Add-on for MI LabVIEW 2013 11,7MB '—
FMI Add-on for MI LabVIEW 2014 11,7 MB
[7] Dymola 74 Export for Pharlap
[7] Dymola 2012 Export for Pharlap
[~ vmola 2012FD01 Expart for Pharlan i

Current selection requires at least 57,4 MB of disk space.

[ < Back ][ Mext > ][ Cancel l

Figure 4 Fourth installer dialog, select the version to install depending on your
VeriStand and LabVIEW Versions.

¢ Modify, if you want, the name of the menu folder that will contain the FMI

FMI To NI VeriStand™ & LabVIEW™ User Guide 9



B Setup - FMI Add-on for NI VeriStand = e e

Select Start Menu Folder
Where should Setup place the program's shorkouts? E

3 i Setup will create the prograr's shortcuts in the Fallowing Start Menu Folder,

To conkinue, click Mext, IF wau would like to select a different Folder, click Browse,

[ < Back ][ Mext = l[ Cancel ]

Figure 5 Fifth installer dialog, select the name you want to use for the folder that
will be inserted on the Start Menu.

e Select Install if you are ready to start the installation. Select Back to redo the

last step.
ks Setup - FMI Add-on for NI VeriStand A=L|IE 2|
Ready to Install
Setup is now ready ko begin installing FMT Add-on For NI YeriSkand onowour
compuker,

Click Install ko continue with the installation, or click Back, iF you want bo review ar
change any settings.

Destination location: -
Ci\Program Files (xaa)\FMUEGNIVS

Setup bype:
Custom installation

Selecked components:
FMI &dd-on For MI VeriStand 2013

Start Menu Folder:
FRUECMING

[ < Back ][ Install ][ Canicel ]

Figure 6 Sixth installer dialog, confirm your choices and start the install the
product.

e After the installation has completed you will find a folder created for the FMI
Connection in the Windows Start menu. Inside that folder you will find links
to the uninstall procedure, to the help application, to the FMI checker
application, to the NI DLL checker application, and to the installation folder
that will look like image 2.7.
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= | & [
&S [0l » Computer » Discolocale (C:) + Programmi (86) » FMUtoNIVS » + [ 42 ][ Cerca MUV ]
Organizza v | Includinellaraccolta v | Condividicon = Masterizza  Nuova cartella = Al @
e~ 4 Nome Tipo Dimensione
B Desktop 2013
# Download Examples
Dymola External
) Risorse recenti License Cartella di ile
3 Dropbex | Resdmetd File TXT 1K8
Progetti (] unins000.dat File DAT 12KB
Projects 2| bl uninso00.exe Applicazione 709K8
14 Raccolte
| Documenti
[ Immagini
& Musica
Subversion
B Video
#d Gruppo home
/8 Computer
&, Disco locale (C:)
€ Rete -
7 elementi

Figure 7 FMI Connection folder.

3. License file installation

After the installation procedure, FMI Connection will be in demo mode. To use the
program fully, a license file must be installed. In order to activate the product, place
the license.lic file in the \FMUtoNIVS\License directory that is found in the
\Program Files on Windows x86 and \Program Files (x86) on Windows x64.

To obtain a license file please write to sales@dofware.com or buy it from
http://sine.ni.com/nips/cds/view/p/lang/it/nid/212841. If you have more than one
license file append the content of all your license files to the license.lic file in the
\FMUtoNIVS\License directory that is found in the \Program Files on Windows x86
and \Program Files (x86) on Windows x64.

4. Install FMI Add-on in NI RT-Target

In order to deploy and run fmu’s on RT target, it is mandatory to install the add-on on
each target. To install the add-on on a target open the Measurement & Automation
Explorer:
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23 Ni-GenericDesktopPC-BAS02674 - Measurement & Automation Explorer (=[E] = |
File Edit View Tools Help

4 B3 My System (O Restart | Sov0 (3 Refresh | ) SetPermissions = Loy T » 7 Hide Help
1> [l Data Meighborhood
| B Devices and Interfaces E@eack R~
1+ 4l Scales System Settings -
& &1 Software LabVIEW Real- B
4 B8 Remote Systems Hostname NI-GenericDesktopP C-BAS02674 Em‘r’Tamf_t
[l NI-GenericDesktopPC-BAS02674 _ onfiguration
19 Address 169.254.112.166 (Ethernet) Complete the folloving
‘ steps to configure your
Vendor MNational Instrurnents remote system for use
with the LabVIEW Real-
Madel Generic Desktop PC Time Module. For a
more complata
Serial Number BAS02674 explanation of these

steps, refer to the
LabVIEW Resl-Time

Status Inconsistent IP Settings I e
larget Lonfiguration
s o Tutorial.
Lomments
1. Bootinto LabVIEW
Real- e
Halt on 1P failure ] 2 Confiaure Netuork
- Lonfigure Network
Protect Restarts ] Settings

m

3. Install Software

4. Configure I/0
System Resources

5. Configure System

Total Phy | Memery 324 GB Settings
Free Physical Memory 307 GB 6. Configure Time

Settings
Primary Disk Capacity 373GB

7. Iransfer User Files
Primary Disk Free Space 37.1G8

When you complate
these steps, your
ramote system is ready
to be targated from
LabVIEW Real-Time.

EI Submit feedback
on this topic.

@ System Settings ‘E Network Settings @ Time Settings | Q i

= Inconsistent IP Settings

Figure 8 Measurement & Automation Explorer

Click on “Software”and then “Add/Remove Software”, locate “FMI to VeriStand
201x” and/or “FMI to LabVIEW 201x” and Install the feature:

ﬁ Software - Measurement & Automation Explorer

File Edit View Tools Help
4 B3 My System [‘E Add/Remove Software €% Shaw Help ‘
1> [3l Data Neighborhood

o
[ @@ Devices and Interfaces
» 44 Scales Software

» &1 Software Software displays the National Instruments software components installed on a LabVIEW Real-
4 B Remote Systems Time target.
4 El NI-GenericDesktopPC-CA2AB4BC
1 [3 Data Neighborhood
3 i‘l Devices and Interfaces

1 4d Scales
&1 Software Select the features to install and installed components to uninstall.

A

13 LabVIEW Real-Time Software Wizard: NI-GenericDesktopPC-CA2AB4BC (192.168.0.60)

%] National Instruments RT Software 4| NILV Add On Simulation Framewark

Broadcom 57xx Gigabit Ethernet Driver 3.1.0.

- %| DataSocket for LabVIEW Real-Time 5.2.0
%| EPICS Client 1/0 Server 14.0.0

- %[ EPICS Server 1/O Server 14.0.0 Version on the remote target: 2014.0
m FMI to LabVIEW 1.5.12014.0

m

FMI to VeriStand 1.5.12014.0
ﬂ E:;::t :u?&?:SOSL Support 14.0.0 Available version(s) on the host: 2014.0 E‘
%| 1/0 variable Remote Configuration Web Servio
Intel 1000e Ethernet Driver 5.1.0
Intel 8254x Ethernet Driver 5.1.0
Intel 8255x 10/100Mbps Ethernet Driver 3.1.0
LabVIEW Real-Time 14.0.0
MI RT Extensions for SMP (MultiCore Suppo
#%| Language Support for Japanese 14.0.0
| Language Support for Simplified Chinese 14
Microsoft Visual Studio 2008 Runtime Suppe
Microsoft Visual Studio 2010 Runtime Suppe
LablWindows/CVI Network Streams for RT 13.0 This feature will remain on the remote target.
LabWindaws/CVI Netwark Variable for RT 13.0
LabWindaws/CVI Run-Time Engine for RT 13.0 X

| anmiane Sinnart frr | 2hUTEW DT 4 0 0 €

7
1 [ 1, »

<< Back Mext => ] [ Cancel ] [ Help

7 Help|

Figure 9 Install FMI Add-on on your target.
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You have FMI support on your RT Target:

> [§@ Data Neighberhood
. g Devices and Interfaces
> 44 Scales
» &1 Software
4 B8 Remote Systems
4[4 MI-GenericDesktopPC-BA502674
> [gl Data Meighborhood
. &) Devices and Interfaces
> 44 Scales
4 5] Software
Broadcom 57xx Gigabit Ethernet Driver 31.0.3.0
FMIto Veristand 1.4.2 2013.0
HTTP Client 12.0.0
Intel 1000 € Ethernet Driver 5.0.0
Intel 8254x Ethernet Driver 5.0.0
Intel 8255x% 10/100Mbps Ethernet Driver 3.1.0.3.0
LabVIEW Real-Time 13.0.0
Language Support for LabVIEW RT 1.0.0.5
Metwork Variable Engine12.0.0
NI System Configuration 5.5.0
NI System Configuration Remote Support 5.5.0
NI VeriStand Engine 2013.0

MNI-DAQmx9.7.0

MI-VISA5.4.0

MWVIDIA Ethernet Driver 31.0.3.0

Remote Panel Server for LabVIEW RT13.0.0
Run-Time Engine for Web Services13.0.0
USE Support 1.5

Variable Client Support for LabVIEW RT 12.00
Variable Legacy Protocol Support 5.5.0

NI'Web-based Cenfiguration and Monitoring 13.0.0

Software

74 Software - Measurement & Automation Explorer O | B |
File Edit View Tools Help
a B3 My System o4 Add/Remove Software &

Software displays the Mational Instruments software components installed on a LabVIEW Real-Time target.

What do you want to do?

& View my software information
& Install software

For more information about using your NI products, refer to your product-specific help, located on the Help»Help Topics
menu item. You can also access NI product help fram within MAX help, which you can launch from the Help menu or by
pressing =F1=.

EI Submit feedback on this topic.

8 Visit ni.com/support for technical support.

% Help

Figure 10 FMI Add-on installed.

Now you can deploy your NI projects including FMU models on your RT target.

FMI To NI VeriStand™ & LabVIEW™ User Guide
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5. Unistallation Procedure

5.1. For Windows

FMI Connection provides an uninstaller. The following steps uninstalls the FMI
Connection.

The uninstaller is found in the start menu. Click Uninstall to open the uninstaller
dialog.

() [l Computer » Disco locale (C) » Programmi (86) » FMUtoNIVS »

Organizza » Includi nella raccolta v Condividi con v Masterizza Nuova cartella

Nome

T Preferiti

Cartella di file
Cartella di file

Cartella di file

Cartella di file

File TXT 1K
File DAT 12K
Applicazione 709 KB

_ Readmet
Progetti ] unins000.dat
Projects _|  hal unins000.exe

ubversion
B video

«d Gruppo home

1% Computer

&, Disco locale (C)

i Rete -

7 elementi

Figure 11 FMI Connection folder - unistall.

6. Support

For Dofware support plays a crucial role in the activity of design-in offer to our
customers as an added value.

Dofware provides a structured support service to customers who have an active
maintenance contract.

Supporting activities include:

¢ Information service on the product features

e Service of information about product features

e Support the installation of the product

e Support for the ordinary and extraordinary maintenance

In case you need technical support, record and report the following informations:
e License Number or Serial Number;

e Number of the invoice;

e Operating System;

14 FMI To NI VeriStand™ & LabVIEW™ User Guide
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e Version of the FMI - Add-on and version of VeriStand and LabVIEW;
e Eventually PXI model and installed software.
To contact Dofware for support you can write to support@dofware.com or call. +39
011 22 37 658.
Operating hours for Support:
Lun-Ven: 8:00 - 13:00 --- 14:00 - 18:00 Europe Time (Amsterdam, GMT+01:00).

The expected turnaround time on a support inquiry is 48h.

7. Export Models in FMI format

7.1. FMI standard

Several modeling tools are able to export models in FMI format, for a complete list of
compliant tools see http://fmi-standard.org/tools. The FMI connection is compliant
with the FMI for Co-Simulation 1.0, FMI for Model Exchange 1.0 and FMI 2.0
specifications. In order to test the compatibility of your models with the FMI to NI
VeriStand Connection you can download the latest version of the FMI compliance
checker from the Modelica Association from see http://fmi-standard.org/ and test
the fmu’s you want to import into VeriStand with it. Otherwise you can use the
application included into the add-on that wrap the same checker. You can find it in
“Start->FMItoNIVS->FMU Checker”.

. Installation Folder

B WIVS 2013 DLL Checker ST

- .
—J I | [ml Data Meighh | B PR Chmcer =
Dymala 2014 FOOL e
Dymala 2015 % lzsmst W RORAA MO H P Dincarresdsd T ol tesd Dot Conncde e | Biowse... |
F
Exscuzans automstica |MEIIFMUCHE] 'wiill praceess FHU Cilzerst Hanco, FOMEN DM\ DocumentDpnoke e Comate_Camglzw o
FEMAF w1024 |HFTIRML FJR1 e Pl staralsid veason | 1
. . [FHELYF l-ll\HL|Hn-c-Hr;n:\len-n.e on ekl Codirdslor FHU deeched,
. FileZslla FTP Client Docwment [HFITFRICHE] M -isd rsrse mceZomnima I'fn-\llll
- [MEDJFWUCHE | Mo denanes tedlongicn
FMURHIVS N EIAICHE] i 61D 7 s T 735201 L
valuati I |FIFTIFMICHE | Misded scia e 1
lnd Evaluation Request S (NG| P ki Sanctive
§ b FMU Checker IHFSEVIEHE] TPl
0
2 Mus
[ Help usica E
e
u
1

. ral v
B Uninstall [P :nu:\les'\..ih c:us:h- mone’

1_ Lizer Guide Pannello di controlla ! 11 et e o
F Meetin ﬁl e :MHJ
uze W wrnsmslaor vaishic:
9 [hspesitiv & starmpants U boe e aities

. Gicehi 12 g <oisblac

G Programmi predefiniti |HFIIPRIICHE] Prict ng cuput 3s hescer

GitHub, Inc . [FIFIIFMILE] Loadng wniE bnay wh dar da s pladioon lppes

- [HPIITRUCHE] Yoz o revaned bon THU. 10

Gnu'Wind2 Guida £ supporto tecnico [FRUIT o FHL aa K] Ticd £l 10 CS dualia

HTML Help Workshop JFRLITE n PRI sz (K s sl BT b il i il e
. Inno Setup 5
1 Indietro

Cherk: FiiLL

Figure 12 FMU Checker window.

In addition, if you want to execute your models into Par Lap ETS on PXI systems, it
is mandatory to check the compatibility of all the dII’s included into your fmu archive
with the NI dll checker
(http://digital.ni.com/public.nsf/allkb/0BF52E6FACOBFIC286256EDB00015230)
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This checker since version 1.4.1 is also embedded into the FMI Add-on, in fact you
are asked to perform a dll check at each FMU import.

7.2. Adding import Parameters into your models

In order to be able to setup configuration parameters for your import in VeriStand or
LabVIEW, the FMI Add-on will read the value of some key parameters in your FMI
model, if present.
In particular you can setup the target rate of your model into VeriStand or LabVIEW
simply adding a top level real parameter named "FMINIVS_FixedStepModel" with
your desired step execution time.
In addition, in order to be able to use fixed step solvers with fixed step time lower
than 0.01 seconds in Windows target, it is possible to setup a top level real parameter
named “FMINIVS_ SuperSampling” in order to impose the FMI connection to super-
sample your model by that integer factor of your choice. This will be used only if the
FMU is executed using the FMI for Model-Exchange API.
Moreover if you export an FMU containing both Model-Exchange and Co-Simulation
API, you will be able to choose which one to use into VeriStand or LabVIEW setting
an integer top level parameter named "FMINIVS_FmuSimType" with the value 1 if
you want to use Co-Simulation API and 2 if you intend to run the model with fixed
step solvers and Model-Exchange APIs.
In particular the FMI Add-on implements the following fixed step solvers:

e Explicit Euler 1
Heun
Explicit Runge Kutta 4" order
Modified midpoint
Runge Kutta Cash Karp54
Runge Kutta Dopri5
Runge Kutta Fehlberg78
Adams Bashforth 10

e Adams Bashforth Moulton 12
To choose which one do you want to use in case you are running your FMU using
Model-Exchange APIs, you have to setup an integer top level parameter named
"FMINIVS _Integrator". Setting the value of that parameter you will choose which
integrator you will use in VeriStand or LabVIEW, accordingly to the indexes
displayed before.
In addition, you can choose how depth the add-on will import model variables, this
affects import time. You will be able to import only first level variables setting a Real
top level parameter named “FMINIVS_LevellOSignalParameters” equal to 0, second
level parameter of type “blockname.variablename” setting its value to 1 and so on.
Finally you can setup the “FMINIVS StopTimeDefined” parameter that specifies if
the model you are importing shuld terminate its execution when reaching the
stopTime value defined in the ModelDescription file of the FMU.

7.3. FMI export from Dymola

16 FMI To NI VeriStand™ & LabVIEW™ User Guide
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From version 2012, Dymola FMU export functionality has been extended to also
support FMI for Co-Simulation specification version 1.0 for export of models (slaves)
with built-in numerical solvers.

The new functionality uses the SUNDIALS suite of numerical solvers (version 2.4.0).
The SUNDIALS code is not distributed with Dymola 2012, but can be downloaded
from the Sundials website (https://computation.linl.gov/casc/sundials/main.html)
or found into the \external\ folder.

To install the SUNDIALS libraries needed to activate the FMU for Co-Simulation
export functionality in Dymola, you can follow the instruction on Dymola manuals or
unzip the package ""\external\sundials-2.4.0.zip™ into the folder **<Dymola2012
installation folder>\Dymola 2012\Source\FMI\"".

Dymola versions since 7.4 can export models in FMU format, but Dymola
installations have to be modified to export FMU that are also Phar Lap ETS
compliant. To do so during the installation process, simply select the Dymola version
you have installed on your machine.

B Installazione di FMI Add-on for NI VeriStand & LabVIEW o= || = || &2

Selezione componenti
Quali componenti devono essere installati? L

Selezionare | componenti da installare, deselezionare quelli che non si desidera
installare. Premere Avanti per continuare.

Installazione personalizzata - |

Dymola 2012 Export for Phar Lap ETS -
Dymala 2012F001 Export for Phar Lap ETS
Dymola 2013 Export for Phar Lap ETS
Dymola 2013F001 Export for Phar Lap ETS
Dymala 2014 Export for Phar Lap ETS
Dymola 2014FD01 Export for Phar Lap ETS
Dymala 2015 Export for Phar Lap ETS
Dymola 2015F001 Export for Phar Lap ETS

m

La selezione corrente richiede almeno 57,4 MB di spazio su disco.

| < Indietro |[ Avanti > l | Annulla |

Figure 13 Dymola FMU exporter installation option.

Now you it’s all set to generate Phar Lap ETS Compliant FMUs from Dymola.
To generate FMU for Co-Simulation from Dymola 7.4 to 2014 please follow the
instructions below:
e Open the FMIAddORN library in Dymola
e Use “File -> Open”. Open FMUTONIVS.moe library located in your
FMUtoNIVS installation folder:
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=RECEN X

@Uv| ;o FMUtoMNIVS » Examples » Dymola » FMIAddOn14.2 » v|#¢|| Cerca FMIADdOn 1.4.2 Pl
Organizza v Includi nella raccolta = Condividi con = Masterizza Muova cartella ;,'i - 0 .@.
W Preferiti 3 EMU images
Bl Desktop 1 | | Cartella di file s Cartella di file
Download r
. R :-: libraryinfo.mos
J, Dymola r ESOUrCEs I X ) .
¥ I Cartella di file | Modelica script
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%# Dropbox package.moe
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4 Raccolte

'~1 Documenti

5 elementi

Figure 14 FMUtoNIVS Dymola example library.

e Call the “FMIAddOn.exportToFMU” function

[E] 1D Contralier - Modelica Blocks Examples.PID.Controller {Read-Only - [(Diagrarm] [=[®] = |

Help  Linear analysis NEE

S0 Z- -4 smBPABEE wn - B-e-von @

Edt Simuaton Plot Anmation Commands  Wind
EeEHAQAS Wi/ OO0¢ ARSI -

Package Browser & X

Packages =
H@NVodelica Reference
= {JModelica

P @User's Guide

| & [@Blocks

i | = p]Examples

H®PID_controler M reference speed generation

H (vt
: i ElterwithDifferentiat, KinematicPTP. integratar
B Dofwarelite tof MU P oS

toFML

Description

m

ple drive train)
Interactive function to export a model as an FIVIU according to FMI for Model Exchange 1.0 and FMI for Co-Simulation 1.0

Medel name o J'wl \nad:ﬂr
Mame of model to be exported "Modelica.Blocks. Examples PID_Controller” %, » — ey
c=Ted =
=100

Generate result

true if FMU should gererate .mat result file =

true if FMU should be checked after generation

Export drectory
Location of exported FMU archive {cd as defauit)
Outputs

rodelldentifier » Mame of the generated fru fle

[ 0K l [ Info ] [Copy Cal\] [ Execute ] [ Close ]

‘ 18 Modeling | P Simulation ‘

Figure 15 Translate model as FMU.

e Select from the gui the model you want to export
e Check the “checkAfterExport” flag
e See if the export procedure ended correctly with the following messages:

fmi instantiation OK
fmi Initialization OK

To generate FMU for Co-Simulation from Dymola 2014FDO01 and newer versions
please follow the instructions below:

18 FMI To NI VeriStand™ & LabVIEW™ User Guide



-19-

e Open the simulation setup window in Dymola;

e Select the FMI tab;

e Select FMI 1.0 format (FMI 2.0 can be selected for Dymola 2015FD01,
previous versions exported in Release Candidate format);

e Select Model-Exchange or Co-simulation using Dymola solvers;
e Select 32-bit platform;

e Select Compiler tab;

e Use Visual Studio Express of Professional Version 2008 or 2010;
e Export FMU in the usual way.

8. Import FMU models in NI VeriStand

To import an FMU model into NI VeriStand follow the instructions below:

e Open NI VeriStand,;

e Create a New project;

e Check your FMU using the official FMU compliace Checker fom the
Modelica Association;

e Copy your FMU into the Project folder;

e Launch the System Explorer related to a System Definition File from the
Project Explorer;

e Load the fmu model:

8 Project Explorer - TestValidationFMI20RCLnivsproj [=l=] = |
File Edit Operate Toals Help |
" § W System Explorer - TestValidationFMIZ0RCLivssdf* l= =
= - S— File Edit Tools Help
BSH % # B = Add a Simulation Madel
© il TestValidationFMRORCL
25 Targets [ ]
S Controll
& H dels (.mail
) Custo calle:
= 4 Simul Model
@ E
Al to 2 system
& User Channel
Fe Calaul .
i also
f",: i ables v
klsor
Proced
XNET Databases
372 Sy
% Aliases | A Select File or Folder ===
a KJKJ [ 1 « TestEvalidazione » TestEDemos » TestValidationFMI20RCL » ~ [ 42| €erca TestvatidationFmizorc: | R
Organizza »  Nuova cartella = 0O @
e 4 Neme Ultima Tipo |
B Desktop Logs 07/04/201418:49  Cartella difile
8 Download Temporary Screen ltems 07/04/201418:39  Cartella difile
Dymola testCompteur_Compteur 12/04/201418:56  Cartella di file L
% Risorse recenti XNET Raw Frame Files 07/04/201418:33  Cartella difile
23 Dropbox || Add_010mu 08/04/201410:47  File FMU -
Progetti | bouncin gBallfmu 12/04/201404:44  File FMU
Projects [ dgdmu 12/04/201404:44  File FMU
| FMIAdOn_Examples_RT_0Robot fullRobot ORT fmu 20/05/20140821  File FMU .
section
3 Raccolte || FMIAddOn_Examples_SimpleExamples_DoublePendulum.fmu  20/05/2014 0819 File FMU
7 Documenti | | FMUTONIVS Examples_CauerLowPassAnalog.fmu 22/11/20121437 __File FMU -
&= Tmmanini s L v —
1 Home file: |
l’)m

Figure 16 Import FMU.

e Save and close the System Explorer Project;
e Open and setup the workspace from the Project Explorer;
e Deploy and run the Experiment.
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9. Use FMU models in NI LabVIEW

To use an FMU model into NI LabVIEW follow the instructions below:

e Open NI LabVIEW;

e Open MIT Simple Load and Run FMU Model.vi from Start->FMITONIVS-
>LabVIEW Examples;

e Check your FMU using the official FMU compliace Checker fom the
Modelica Association;

e Copy your FMU into the C:\Program Files (x86)\National
Instruments\LabVIEW 2013\examples\Control and Simulation\Model
Interface\Models folder;

e Modify the path of the model accordingly to the name of the fmu model that
you just added into the Models folder;

e Modify the input and output array of variables accordingly to your FMU
model I/O interfaces;

e Run your vi;

This is just an example to get started, if you want to use your models in more complex
vi, just threat your fmu models as dll models built with Model Interface Toolkit
specifications.

43 MIT Simple Load and Run FMU Model.vi Block Diagram [=]=]=]
File Edit View Project Operate Tools Window Help
B[Ol [E]E] o 7=
=
| Error M
— Error __ time Scale Factor I E— Expected End [i-1] M
vz, mon ||| Exected End [i-1] v C e S ActualEnd [i-1] ¥
3 Actual End [i1] pr el INNE nished Late? [id]
b [1eaasT] Finished Late? !-1 ¥ bt0 | Global End Time ¥
Load the FMU model and obtain vidv [ Expected Start [i] v bz B J Iteraticn Duration W
. . b0 [ | Actual Start [i L re J Processor Y
the sampling time R Period [ boy [T
b o5 DT vl 1 ]
e
1000
e y
u L]
v L
r} ’—*—*—i { RG]
= =) )
................. ! s ' BT
Model Period (s)
5 m stop [TEg-292-@]
% .\Models\Modelica Blocks Math_sin.fmu| |Call the model for each timestep until the stop button is
pressed. The input (or inport) parameter defines the offset of
the signal.
Evaluation < [T} +

Figure 17 LabVIEW vi that calls and execute an FMU model.
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{3 MIT Simple Load and Run FMU Model.vi =N R
File Edit View Project Operate Tools Window Help
[ [@[n ﬂ
Overview: This example describes how to programmatically call an FMU Model and run this model in LabVIEW.
Requirements: LabVIEW Model Interface Toolkit
Instructions:
1. Run the VI
2. Change the input signal u and verify how this changes the output (or outpert y) of the model.
Sine [/
¥ 5 . u
- p
time Scale Factor L=
- - 0,8 2=
10- 0,6-
15- 0,4 0-
5 w ga- -2-
BT 1314-
25 2 0-
E —
(01 ] < -0,2- =-3.14
— ) 04 :
=il
L J 0,6
) ) 08— rModeI Pericd (s]\
B stop ad 0,00
L J 1 1 L
22 26
Time
Evaluation | « i1 b

Figure 18 VI GUI execution output.

10. Getting Started
10.1. Introduction

This chapter will take you through one example in order to get you started with FMU
to NI VeriStand & LabVIEW Connection.

10.2. FMU Connection: Step by Step example

10.2.1. Prerequisites
e FMU 1.0 or 2.0 compliant

e NI VeriStand 201x
e FMU to NI VeriStand & LabVIEW Connection 201x

10.2.2. Generate and check your FMU

The first step of the process consists in the generation and check of the functional
mock-up unit. The FMU can be hand coded or exported from an FMI modelling tool.
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In this starting tutorial we used an fmu containing the
Modelica.Mechanics.MultiBody.Examples.Systems.RobotR3.fullRobot model example
from the Modelica Standard Library version 3.2:

fullRobot_RT - FMIAddCn.Examples.RT_Robet.fullRobot RT (Encrypted) - [Diagram]

File Edit Simuation  Plot Animaton  Commands  Window  Help  Linear analysis
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| +[FpathPlannings
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axisd
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‘ 12 Madeling | ¥ Sirmulation ‘

Figure 19 fullRobot example.

Once you generate the fullRobot.fmu file with your modelling tool, you have to check
the compliance for the import in VeriStand using the FMI Checker.

If your FMU DLL works on a Windows machine it MAY work in LabVIEW Real-
Time (NI Phar Lap ETS). However, if your code is making function calls that are not
included in the Win32 subset that the real-time operating system has, then the code
will fail. Use the utility you can download at
http://digital.ni.com/public.nsf/allkb/OBF52E6FACOBFIC286256EDB00015230 to

assist you in determining whether or not the function calls in your DLL are supported
on the real-time operating system.

Moreover the FMI Connection works only with FMU compliant models, it is highly
recommended to check the compatibility with the FMI 1.0 or 2.0 standard
specifications using the official FMI compliance checker you can download at:
https://www.fmi-standard.org/downloads, or using the application included into the

add-on that wrap the version 2.0.1 of the checker. You can find it in “Start-
>FEMItoNIVS->FMU Checker”.

Now you can use FMUToNIVS_Examples_fullRobot.fmu in VeriStand.
Open NI VeriStand 201x and create a new project:
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A4 Getting Started Window ClEE

File Tools Add-Ons Help

. W Create New Project ‘ ‘
&l New NI VeriStand Project __

Project [ System Definition I Properties

Most Recent Projects
B Project Name
[ls}; TestValidationFMI20RC1 :

MyMNewProjectName
= o
&} RT Validation Project Root Folder
[‘k'jz Engine Demo C\Users\Public\Documents'National Instruments'\NI VeriStand ;

2013\Projects
[ls); Sinewave Delay

Create folder for project
Project Path

| C:\Users\Public\Documents'National Instruments\NI VeriStand 2013\
| Projects\MyNewProjectName\MyNewProjectName.nivsproj

kﬁ Browse

[ OK ] [ Cancel l [ Help

BEL Configure Project El Run Project

Figure 20 Open NI VeriStand and create a new project.

Copy in the folder project (by default: C:\Users\Public\Documents\National
Instruments\N I VeriStand 2013\Projects\<your project name>) the
FMUTONIVS_Examples_fullRobot.fmu file:

R Project Explorer - MyNewProjectName.nivsproj * =[S
File Edt Operate Tools Help

H| & | X | P> ||«
TN MyNewProjectNump
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[ 43 Dependencie

Deploy =B %

\J) « NIVeriStand 2013 » Projects » MyNewProjectName » v|4,H Ces whroject... D |
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L@ Dimensione: 7.92 KB

Figure 21 .fmu file in your project folder
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Open the System Explorer:

R System Explorer - MyNewProjectName nivssdf

File Edit Tools Help

== System Mappings
%, Data Sharing Network
3 System Initialization

S H % ==
B-m E
T System Explorer Window
‘.:‘ ;\\ia‘ses Use this window to create and/oer modify a system definition file. You configure a system definition file by adding,

removing, and medifying optiens in the configuration tree, located on the left of the System Explorer window.
Using the System Explorer window, you can define various companents of the system, including alarms,
calculated channels, hardware 1/, systern mappings, procedures, simulation medels, system channels, user
channels, and some VeriStand Engine execution settings.

m

For more information about using the System Explorer window, refer to the Configuring and Running & Project
beok of the NI VeriStand Help, available by selecting Help»Search the NI VeriStand Help.

Refer to the Components of & Project book for detailed descriptions of system definition files and the VeriStand
Engine.

System Definition File Settings

Mame

MyhlewPrajecthlame

Creatar Creation date
14:10:17 12/04/2014

Description

Revision history

Figure 22 System Explorer

Specify the target, in this example | selected a PXI target running Phar Lap ETS:

&4 System Explorer - MyNewProjectName.nivssdf

= 2|

File Edit Tools Help

=3 System Mappings
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W3 System Initialization

BOH | s wEA D
= gl MyNewProjectMame A
BE- Target|
il Controller Targets
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44 Scales

What do you want to do?
Add a target

-
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To remaos

te button. Deleting a target
also rem
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B s
S

Description
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Figure 23 Define RT Target.

Select the fmu model your want to import in NI VeriStand (you should already put it
in your project folder):
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Figure 24 Load fmu model.

In this stage a message will pop-up asking you if you want to check your model for
Phar Lap ETS compliancy. If you are planning to run your model selecting a Phar Lap
ETS target it is highly recommended to do so, in order to be sure that the dll inside the
FMU you are importing is Phar Lap ETS compliant. If the Check will fail you will be
notified with a warning that you will be able to run your model only on windows

target.

See your FMU model in VeriStand System Explorer Models tree:
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System Explorer - MyNewProjectName.nivssdf*
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Figure 25 fmu model in VeriStand.

Save your model, close System Explorer and in the Project Explorer run the project

(Operate > Run).

26

FMI To NI VeriStand™ & LabVIEW™ User Guide




A4 Running Project
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Figure 26 Running Project.

In the Workspace you can monitor and modify your 1/O variables:
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Figure 27 Load your model info.
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Figure 28 Your model deployed on RT Target.
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11. Release Notes

11.1. Version 1.5.1

FMI To NI VeriStand™ & LabVIEW™ Add-on Version 1.5.1 enables the import of
all FMU signals into VeriStand and LabVIEW, moreover the dependency of Visual
Studio Runtime libraries in Windows has been eliminated.

11.2. Version 1.5

A number of improvements and additions have been implemented in FMI To NI
VeriStand™ Add-on Version 1.5. In particular, FMI To NI VeriStand™ Add-on
Version 1.5 provides:

e Support for the new version 2.0 of the FMI standard.

e Full compliance and Validation against all Test FMUs from fmi-stanndard.org

website.

e New integrators for ModelExchange FMUs, in particular:
Modified midpoint
Runge Kutta Cash Karp54
Runge Kutta Dopri5
Runge Kutta Fehlberg78
Adams Bashforth
Adams Bashforth Moulton

= = O 0~ o

O O O O O O
N O

11.3. Version 1.4.5

FMI To NI VeriStand™ Add-on Version 1.4.5 enables LabVIEW Model Interface
Toolkit to import natively FMU models.

11.4. Version 1.4.4

FMI To NI VeriStand™ Add-on Version 1.4.4 is a functional delivery version,
released to handle licensing support for NI VeriStand 2014.

11.5. Version 1.4.3
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FMI To NI VeriStand™ Add-on Version 1.4.3 is a functional delivery version,
released to include support for NI VeriStand 2014.

11.6. Version 1.4.2

FMI To NI VeriStand™ Add-on Version 1.4.2 is a functional delivery version,
released to include support for handling of stop time definition on imported FMUSs.

11.7. Version 1.4.1

FMI To NI VeriStand™ Add-on Version 1.4.1 is a functional delivery version,
released to include support for automatic dll check for Phar Lap ETS compliace on
the imported FMUs.

11.8. Version 1.4

A number of improvements and additions have been implemented in FMI To NI
VeriStand™ Add-on Version 1.4. In particular, FMI To NI VeriStand™ Add-on
Version 1.4 provides:

e Support for the new version 2.0 RC1 of the FMI standard.

e Compliance for the import and the tuning in Real Time during the model
execution of the parameter that have variability equal to “tunable” in the
modelDescription xml file of the imported FMU.

e Full compliance and Validation against all Test FMUs from fmi-stanndard.org
website.

30 FMI To NI VeriStand™ & LabVIEW™ User Guide



